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“The Official Ubuntu Book is a great way to get you started with Ubuntu,
giving you enough information to be productive without overloading you.”

—John Stevenson, DZone book reviewer

“OUB is one of the best books I’ve seen for beginners.”

—Bill Blinn, TechByter Worldwide

“This book is the perfect companion for users new to Linux and Ubuntu.
It covers the basics in a concise and well-organized manner. General use
is covered separately from troubleshooting and error-handling, making
the book well-suited both for the beginner as well as the user that needs
extended help.”

—Thomas Petrucha, Austria Ubuntu User Group

“I have recommended this book to several users who I instruct regularly on
the use of Ubuntu. All of them have been satisfied with their purchase and
have even been able to use it to help them in their journey along the way.”

—Chris Crisafulli, Ubuntu LoCo Council, 
Florida Local Community Team

“This text demystifies a very powerful Linux operating system . . . In just a
few weeks of having it, I’ve used it as a quick reference a half-dozen times,
which saved me the time I would have spent scouring the Ubuntu forums
online.”

—Darren Frey, Member, Houston Local User Group
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Foreword to the Sixth Edition

xix

THE OFFICIAL UBUNTU BOOK CAPTURES both the spirit and the precision with
which Ubuntu itself is crafted. Like Ubuntu, it has evolved in a steady
cadence of regular releases, and this sixth edition reflects the cumulative
insight gained from prior editions, as well as some of the latest innova-
tions driving Ubuntu forward.

2011 is a critical year of change for Ubuntu, as we move towards the new,
unified interface called Unity. Our goal is to deliver what people have long
wished for: the world’s cleanest, most elegant desktop experience, as free
software. 11.04 is the first major step in that process as we introduce Unity
by default on the desktop, retaining the Classic GNOME desktop for those
who cannot yet make the leap to Unity.

Our broader goal is to challenge the free software ecosystem to invest as
much creativity and energy in design as it does in engineering. We know
that free software can be the best in the world for performance, reliability,
and security; now it’s time to bring ease-of-use and stylishness into the
mix too.

I hope you enjoy 11.04, and love this book. My thanks to the many folks
who have made both Ubuntu and The Official Ubuntu Book possible. It’s a
great privilege to be part of this community.

—Mark Shuttleworth
Ubuntu Founder

April 2011
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Foreword to the First Edition

xxi

IT’S A SMALL CELEBRATION for me to write this foreword—almost exactly
two years after the first meeting of a small group of free software profes-
sionals that turned into the Ubuntu project. A celebration because two
years ago none of us would have predicted that our dream would spawn
several million CDs, three or four million enthusiastic users, hundreds of
commitments of support from companies large and small, a minor prime
time television reference, and now The Official Ubuntu Book.

The dream that brought us together can be simply expressed:

To build a world-class operating system for ordinary desktop computer
users, that is genuinely free and freely available, that is immediately useful,
and that represents the very best that the free software world can achieve
today.

In setting out to build a platform for “ordinary desktop computer users,” I
had no idea that I would have the privilege of meeting and working with
so many extraordinary desktop computer users. Some of those extraordi-
nary individuals are the authors of this book, people who both understand
the importance of the free software movement and have the talent to have
been real contributors to its success. Others make up the backbone of the
Ubuntu community—the small but dedicated army of a few hundred
people that works to produce a new release of Ubuntu every six months.
They are at the heart of a network that reaches out through the global free
software community—through the world of Debian, an extraordinary
project in its own right and without which Ubuntu could not exist, and on
out to the thousands of projects, large and small, that produce the code
and documentation that we pull together and call Ubuntu.



While this huge extended community can often appear to be fractured and
divided along infinitesimal ideological lines, we are all broadly in agreement
about four key ideas, and it is those ideas that are central to the Ubuntu
promise:

� That our software should not come with a license fee. That we should
be able to share our software, modify it, and then share our modifica-
tions, too.

� That this free software should be the best version available, including
regular security updates, and not a tease for a better, commercial
product.

� That full-scale, high-quality commercial support from local and
global companies should be available for this free platform.

� That this software should be usable in as many languages as possible
and usable by as many people as possible regardless of disability.

The 17 of us who met in London two years ago come from a very wide
variety of countries and backgrounds, but we all agreed that the goal of
producing a platform that could live up to that promise was a worthy one,
one that we would devote ourselves to wholeheartedly.

For several months we worked quietly. We wanted to come to the world not
only with a manifesto but also with a clear demonstration of work done
toward our goals, something that people could test and comment on. We
had no name (though industry insiders called us the “Super-Secret Debian
Startup”), and, as a result, we hosted most of our work at www.no-name-
yet.com. We were looking for a name that could express the beauty of the
free software community development process—collaboration, interde-
pendence, sharing, standing gently on the shoulders of giants, and reaching
for lofty goals. The only word that comes close to that, of which I’m aware,
is the African word ubuntu. It is found in many forms in many different
African languages. And so we adopted it as the name of our project. 

We knew that our first release would have blemishes—warts—and gave it
the codename “The Warty Warthog.” We called ourselves “the warthogs”
and coordinated our work on the #warthogs IRC channel. Today, for bet-
ter or worse, that’s turned into a tradition of codenames such as “Breezy
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Badger” and “Dapper Drake.” As lighthearted as they sound, these code-
names come to embody the spirit of our community as it works toward a
particular release. This next one—Dapper—is exactly that: a man emerg-
ing from youth, professional, bold, confident, and energetic. This is our
first release that is designed to meet the needs of large organizations as
much as developers and engineers. In the same way, the Ubuntu commu-
nity has moved from being something of a rebellion against the “Linux
establishment” to a strong and professionally organized group.

What Makes Ubuntu So Popular?
First, this is the time for free software to come to the forefront, and
Ubuntu is very much the beneficiary of the vast amount of work that has
gone into building up a huge body of work in the GNU/Linux world. That
work has been underway for nearly 30 years, in one form or another, but
Ubuntu is one way in which it is suddenly becoming “visible” to the non-
specialist computer user. We are in the middle of a great overturning of the
industry status quo. The last time that happened, in the mid-1990s, was
when the world suddenly found itself connected to itself—by the Internet.
Every major company, especially those in the field of technology, had to
examine itself and ask the question, “How do we adapt to an Internet
world?” Today, every major technology company has to ask itself the ques-
tion, “How do we adapt to a free software world?”

I would speculate and say that Ubuntu represents an idea whose time has
come. We did not invent the free software movement—that honor goes to
Richard Stallman and many others who had a vision far more profound at a
time when it was hard to see how it could ever become reality. But Ubuntu
has perhaps the honor of bringing that vision to a very wide audience in a
form that we can all appreciate. I hope that the real visionaries—those who
have led the way—will appreciate the decisions and the choices we make in
bringing you this project. Some will take exception—I know Linus prefers
KDE to GNOME, for example, so he’s likely to be more of a fan of Kubuntu
than Ubuntu. But in general, the ideas that others have had, the principles
of the free software movement, are well expressed in Ubuntu.

Second, Ubuntu is a project on which you can have a real impact. It has the
benefit of deep and reliable financial backing and a corporate team to give
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it muscle, but it is in every regard an open project, with participation at the
highest levels by true volunteers. We work in a fishbowl—our meetings take
place online, in a public forum. That can be tricky. Building an operating
system is a fast-paced business full of compromise and tough decisions in
the face of little information. There are disagreements and dirty laundry,
and mistakes are made. (I should know; some of them are mine. You should
hear the one about the Warty Warthog desktop artwork.) The transparency
of our environment, however, means that we can count on having robust
conversations about our options—all of them, even the ones the core team
would never have dreamed up. It also means that mistakes are identified,
discussed, and ultimately addressed faster than they would be if we lived
and worked behind closed doors. You get a better platform as a result.

We work hard as a community to recognize the contributions of all sorts
of individuals—advocates, artists, Web forum moderators, channel opera-
tors, community event organizers, writers, translators, people who file and
triage bugs . . . whatever your particular interest or talent, we will find a
way to integrate your contribution.

Perhaps most important is the way our approach to community differenti-
ates Ubuntu from other free software projects with similar vision. We try to
do all of this in a way that recognizes that disagreements are important but
prevents those disagreements from creating deep divides in our commu-
nity. Our code of conduct may not be perfect, but it reminds each of us to
remember the meaning of the word ubuntu—that each of us has our best
impact through the relationships we maintain with one another. Finding
common ground and maintaining healthy communication are more
important for us as a community in the long run than a particular technical
decision or the specific choice of words with which to translate “File” into
Spanish. Our community governance structures—our Technical Board
and Community Council—exist to ensure that debates don’t become per-
sonal and that decisions can be taken after all sides have been heard.

If you are a software professional or curious about Linux, this book and this
platform are an excellent choice. You will learn about the world of Ubuntu
and, indirectly, Debian and GNU/Linux. These are great foundations for
working with the tools that I believe will come to define the “standard,” the
everyday computing base upon which we build our homes and offices.
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I once heard a proprietary software vendor say, “Linux is more expensive
because skilled Linux professionals are more costly.” This is true. It means,
of course, that Linux skills are more valuable! It won’t be true forever
because the world of Linux is expanding so rapidly that sooner or later we
will have to accept a position in the mainstream, and that takes off some of
the “geek points” associated with being part of the “future of technology.”
But right now, without a doubt, being ahead of the curve on Linux and on
Ubuntu is the right place to be. If you’re this far into this foreword, you are
clearly going to make it. ;-) 

It’s difficult for me to speculate on what the future might hold for the
Ubuntu project. I know that I along with many others are loving the
opportunity to be at the center of such an exciting initiative and are com-
mitted to seeing where it leads us over the coming years. I believe that it
will become a pervasive part of our everyday computing environment, so I
would like to help make sure that we don’t make too many mistakes along
the way! Please, come and join us in the fishbowl to help ensure we do a
very, very good job.

—Mark Shuttleworth
Ubuntu Founder

April 2006
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WE HOPE YOU ENJOY THE OFFICIAL UBUNTU BOOK. There are many changes we
made for this edition, which we believe takes an already good book to a
new level. 

Because Ubuntu has risen in popularity and is better known, we have
expanded the intended audience from pure beginners to also include those
who know a bit about Ubuntu but who want to improve their skills and
become power users. These are not necessarily focused on becoming pro-
grammers or systems administrators, but regular people who want to
make their day-to-day use of Ubuntu more efficient or who want to better
harness Ubuntu’s potential.

In 2011, Ubuntu received the first wide release of the new Unity inter-
face. This has been refined to become more elegant, more powerful, and
more useful. These changes are outlined in this book. While the first
release was exciting but incomplete, we believe you will find that the
12.04 Ubuntu edition of Unity delivers a new and exciting standard for
human-computer interaction.

Finally, a large part of this book has been rewritten—not because the earlier
editions were bad, but because so much has happened in the last year since
the previous edition was released. This book chronicles the major changes
that affect typical users and will help anyone learn the foundations, the his-
tory, and how to harness the potential of the free software in Ubuntu.

As we write this, it has been several years since we penned the first edi-
tion of The Official Ubuntu Book. Over that time, we have seen Ubuntu
continue its explosive growth. Updating this book drives this fact home

xxvii

Preface



in striking ways. For example, the number of users and posts in the
Ubuntu Forums has nearly doubled since the last edition of this book a
year ago. Again. 

Once again, we feel blessed that The Official Ubuntu Book has been able to
benefit from, and perhaps in a small way even contribute to, that success.
Ultimately, that success paved the way for several subsequent editions, and
now the seventh edition, of the book that you’re reading now.

In the process, this book, like Ubuntu, continues to mature. Our job as
authors, like that of the Ubuntu developers, now involves more updating
and polishing than it used to. Distributed under a free license, a once-risky
book on a once-risky operating system is, just a few short years later, as
close to a sure thing as an author, publisher, and, if we have done our job
well, a reader could hope for.

And yet with success comes responsibility to our readers and to our users
with high expectations. Ubuntu’s success is built in part of maturity and
excellence, and it cannot sacrifice these qualities if it will succeed. We can-
not either. Our job as writers is complicated because we need to accurately
reflect and represent both qualities while catering to an increasing and
increasingly diverse group of users.

As we’ve noted in the prefaces to previous editions of this book, being
Official has carried with it a set of rights and responsibilities. Our book’s
title means that we must attempt to reflect and represent the whole Ubuntu
community. While we, as authors, are expected to put ourselves into the
book, it is understood that it can never be to the detriment of the values,
principles, technologies, or structures of the Ubuntu community.

Doing this has been complicated as Ubuntu has grown. In each edition, we
have added new information, because the Ubuntu community has grown
to include new projects. In each revision of this book, we have needed to
add to the list of related projects, tools, and community initiatives. As the
Ubuntu community grows, it is impossible to give a complete accounting
of what Ubuntu has to offer. Creating a summary requires some hard deci-
sions. At the end of the day, we are constrained by page count and our own
limited schedules.
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Meanwhile, as with earlier editions, we needed to write this book about a
new release of Ubuntu while that version was under active development
and was being redesigned, rethought, and rebuilt. Every day, Ubuntu grows
in different, unpredictable ways, and this growth has increased exponen-
tially with the size of the community and the diversity of the userbase. Our
book’s development process had to both match and track this process as
our content was crafted, rewritten, adjusted, and allowed to mature itself.

As in the previous edition, the contributors to this book go well beyond
those listed on the book’s cover. Invisible to most readers, dozens of mem-
bers of the community left their mark on different parts of the text of this
book. Although this degree of participation led to a writing process that
was as hectic, and at times frustrating, as the process that builds Ubuntu,
we hope we can remind readers of the level of quality that this process
inspires in our book’s subject. In the places where we achieve this, we have
earned our book’s title. With that goal in mind, we look forward to future
versions of Ubuntu and editions of this book wrought through the same
community-driven process.
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xxxv

WELCOME to The Official Ubuntu Book, Seventh Edition!

In recent years, the Ubuntu operating system has taken the open source
and IT world by storm. From out of nowhere, the Little Operating System
That Could has blossomed into a full-featured desktop and server offering
that has won over the hearts of users everywhere. Aside from the strong
technical platform and impressive commitment to quality, Ubuntu also
enjoys success because of its sprawling community of enthusiastic users
who have helped to support, document, and test every millimeter of the
Ubuntu landscape.

In your hands you are holding the official, authorized guide to this impres-
sive operating system. Each of the authors selected to work on this book
has demonstrated a high level of technical competence, an unbridled com-
mitment to Ubuntu, and the ability to share this knowledge in a simple
and clear manner. These authors gathered together to create a book that
offers a solid grounding to Ubuntu and explains how the many facets and
features of Ubuntu work.

About This Book
At the start of every book, on every bookshelf, in every shop, is a para-
graph that sums up the intentions and aims for the book. We have one
very simple, down-to-earth aim: to make the Ubuntu experience even
more pleasant for users. The Ubuntu developers and community have
gone to great lengths to produce an easy-to-use, functional, and flexible
operating system for doing, browsing, and creating all kinds of interesting
things. This book augments that effort. With such an integrated and flex-
ible operating system, this guide acts as a tour de force for the many things
you can do with Ubuntu.



The Scope of the Book
With so much to cover, we had our work cut out to write a book that could
cover the system in sufficient detail. However, if we were to write in depth
about every possible feature in Ubuntu, you would need to buy a new
bookcase to store the sheer amount of content.

Part of the challenge in creating The Official Ubuntu Book was selecting the
topics and content that can be covered within a reasonably sized book. We
have identified the most essential content and written only about it. These
chosen topics not only include installation, use of the desktop, applications,
multimedia, system administration, and software management, but also
include a discussion of the community, online resources, and the philoso-
phy behind Ubuntu and open source software. As a bonus, we expanded
our discussion of projects related to Ubuntu that will be of interest to you.
We believe this book provides an ideal one-stop shop for getting started
with Ubuntu.

The Menu
Here is a short introduction to each chapter and what it covers.

� Chapter 1—The Ubuntu Story: This spirited introduction describes
the Ubuntu project, its distribution, its development processes, and
some of the history that made it all possible.

� Chapter 2—Installing Ubuntu: We walk through the installation
process one step at a time to clearly describe how anyone interested
may begin using Ubuntu on their own computer.

� Chapter 3—Getting Started with Ubuntu: This is an informative and
enjoyable introductory tour of Ubuntu, and the reader’s first
introduction to the more practical content of the book.

� Chapter 4—Becoming an Ubuntu Power User: We explore some of the
advanced ways to use Ubuntu. This is the chapter for users who want
to move up from basic use, but who do not intend to become
programmers or professional systems administrators.

� Chapter 5—Finding and Installing Ubuntu Applications: Here you
will learn about the vast contents of the Ubuntu software repositories
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and how to take advantage of them. Several examples of useful
software that is not installed by default are highlighted.

� Chapter 6—Customizing Ubuntu for Performance, Accessibility, and
Fun: Learn how to bend Ubuntu to better fit your needs or whims. 

� Chapter 7—Welcome to the Command Line: Begin to take advantage
of the power and efficiency of the command line with the clear, easy-
to-use examples in our brief introduction.

� Chapter 8—The Ubuntu Server: This introduction to Ubuntu Server
installation and administration includes coverage of command-line
package management, basic security topics, and advanced installer
features like logical volume management and RAID.

� Chapter 9—Ubuntu-Related Projects and Derivatives: There are a
number of Linux distributions based on Ubuntu that you will find
interesting and possibly useful. We discuss some of these as well as
projects that are integral to the creation of Ubuntu, such as
Launchpad and Bazaar.

� Chapter 10—The Ubuntu Community: The Ubuntu community is
larger and more active than many people realize. We discuss many of
its facets, including what people like you do to build, promote,
distribute, support, document, translate, and advocate Ubuntu—and
we tell you how you can join in the fun.

The Ubuntu team offers several installation options for Ubuntu users,
including CDs for desktop, alternate install, and server install. These three
CD images are conveniently combined onto one DVD included in the
back of this book, allowing you to install Ubuntu for different configura-
tions from just one disk. There is also an option to test the DVD for defects
as well as a memory test option to check your computer.

The first boot option on the DVD, Start or Install Ubuntu, will cover most
users’ needs. For more comprehensive information, check the Help feature
by selecting F1 on the boot menu. You can also refer to Chapter 2, which
covers the Ubuntu installation process in detail.

You can find the DVD image, the individual CD images (for those who
don’t have a DVD drive), and Kubuntu and Ubuntu Server on www.ubuntu.
com/download.
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IN ADDITION TO THOSE INSTALLED BY DEFAULT, Ubuntu offers a wealth of
other applications to help you make the most of your computer. Different
people use their computers in different ways, and it is for that reason that
we wanted to help you discover how to enable your Ubuntu computer to
do even more.

Chapter 3 includes a brief introduction to the Ubuntu Software Center
as one way to install or remove software. Here we cover this and other
methods as well. Work done using one tool to add or remove software is
recognized by the related tools, so it is okay to mix and match which
ones you use.

Additionally, we show you just a few of the thousands of additional appli-
cations that you can install on your Ubuntu system. Each section show-
cases one application, starting with the name of the package you need to
install and what Windows/OS X equivalents might exist.

Using Ubuntu Software Center
Like other tools discussed later in this chapter, Ubuntu Software Center
installs software from the online Ubuntu software repositories.

To launch Ubuntu Software Center, click the Dash Home icon in the
launcher at the left of the desktop. In the search box at the top of the menu
that appears, type Ubuntu and the search will begin automatically. Click
the Ubuntu Software Center icon that appears in the box. When it is run
for the first time, and occasionally afterward, it will take a few moments to
initialize itself and the list of available and installed applications. Once this
is complete, you will see the main screen shown in Figure 5-1.

We introduced the basics of the Ubuntu Software Center earlier in Chap-
ter 3. Let’s look at some of the other aspects now.

Ubuntu Software Center Account
Some features require an Ubuntu Software Center account, mainly those
that require money or allow tracking (which will automatically reinstall
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previous purchases). When required, it is noted in the section. This
account is the same as the Ubuntu Single Sign-On account that is required
for using Ubuntu One and other Ubuntu services that are available online
like the Launchpad bug tracker described in Chapter 9. If a feature
requires an account, a window will pop up to make signing up simple, as
in Figure 5-2.

Recommendations
Click Turn On Recommendations at the bottom of the Ubuntu Software
Center window (Figure 5-1) to allow the program to send nonidentifying
information about the software you have already installed. This informa-
tion is used to generate suggestions for you based on statistical trends. The

Figure 5-1 Ubuntu Software Center main screen



software you have installed is compared to the software other people have
installed on their machines as recorded in an anonymous database, and
suggestions are given to you. This works kind of like Amazon’s “people
who like the book you are looking at now also like . . .” feature and is quite
convenient. Although the database used for this feature is anonymous,
people who care deeply about their privacy and don’t want to take chances
are not forced to use it; this is why you must choose to turn it on rather
than it being enabled by default.

You need to create an Ubuntu Software Center account to use this feature.

Sorting
Click a category name at the left of the Ubuntu Software Center window
to sort the listed software by category. Some categories are further broken
down into smaller subcategories, such as the Games listing shown in Fig-
ure 5-3. Note that books and magazines are now available instantly in their
digital format via the center.

You can also sort packages from the top of the window using the buttons,
as in Figure 5-4. Click the arrow next to All Software or Installed to limit
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what is displayed by whether it is provided by the Ubuntu community, by
Canonical partners, or available only for purchase. Click the All Software
or Installed buttons to alternately show all available packages or only those
currently on your machine. Click History to list all changes, installations,
updates, and removals of software that have occurred on your machine. 

Searching
Type search terms in the search box at the upper right to find related soft-
ware. The search is a live search, meaning that the results are updated as
you type; you do not have to hit Enter first, and you can change the terms
and get new results instantly, as in Figure 5-5.
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Figure 5-3 Many sorts of games are available.

Figure 5-4 More about software sources coming up



Learning More about a Package and Installing It
Click on a title to learn more about it (Figure 5-6). Notice the line that says
Free at the left (more on that in the next section) and has an Install button
on the right. Click Install to install the software.

At the bottom of the information section is a link titled Developer Web
Site, which opens the software developer’s Web site, giving you easy access
to more information to assist your decision. Further information about a
package—the specific version of the package, its size and license, and
more—is included below this and just above the Reviews section.
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Figure 5-5 It was not necessary to finish typing “word processing” to get results.



Scroll down to read reviews and ratings, if any have been posted for the
package (Figure 5-7). You can sort the reviews using the drop down boxes
just above the first review.

No-Cost Software
Most of the software available from the Ubuntu Software Center is free, as
in it will not cost you anything to download and install it (and is also free
in the licensing sense as well). These are marked Free, like Stellarium is in
Figure 5-6. You pay nothing for this software and it is completely legal for
you to copy it, use it, share it, and so on.
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Figure 5-6 Most package listings include screenshots and valuable information.



Software for Purchase
Sort using the For Purchase category (Figure 5-4) to display only the pack-
ages that require payment. Most of these are digital versions of books and
magazines, although some professional software packages are also avail-
able, such as games and utilities offered by Canonical partners (Figure 5-8).
These are marked differently, with a price in the spot where others are
marked Free and a Buy button where others are marked Install. Also, many
of these come with proprietary software licenses, so do not assume you
can legally share packages you pay for.

You need to create an Ubuntu Software Center account to use this feature.
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Figure 5-7 Users tend to be honest in their software reviews.



Learning Terminology and Foundations
You might want to know a few terms before we continue. These are words
used to describe how the software gets installed on your machine as well as
how the system works.

� APT: Advanced Package Tool, or APT, describes the entire system of
online repositories and the parts that download them and install
them. This is not highly visible when using graphic interface–based
systems like Ubuntu Software Center but very clear when using
command-line tools like apt-get, which is described in greater depth
in Chapter 8. Whether you use a graphical interface or the command
line to deal with Ubuntu software packages, APT is at work.

� Repositories or software channels: In the Ubuntu world, these giant
online warehouses of software are divided between official Ubuntu
repositories and unofficial ones.
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Figure 5-8 Compare this package information screen with Figure 5-6.



� Packages: Applications are stored in packages that not only describe
the program you want to install but also tell your package manager
what the program needs to run and how to safely install and uninstall
it. This makes the process of dealing with software dependencies
smooth and easy for end users.

� Dependencies: Dependencies comprise the software that is needed as
a foundation for other software to run. For example, APT is needed
for Ubuntu Software Center to run because APT takes care of many
of the details behind the scenes.

Using Synaptic
Synaptic is a powerful graphical tool for managing packages. It is not
installed by default. While Ubuntu Software Center deals with packages
that contain applications, Synaptic deals with all packages, including
applications, system libraries, and other pieces of software. Changing the
system on this level is more complicated but also allows more detailed
control. For instance, you can choose to install a specific library if you
need it for a program that is not available in a package format.

TIP What’s a Library?
In this context, a library is a collection of software functions that may be useful to more than
one program. This collection is put into a separate package to save space by not forcing
multiple programs to include the same code but instead simply refer to the library when a
certain function the library contains is needed. It also makes updates easier, such as when a
security issue is fixed, because the programming code may be changed in one place while
benefiting all programs that use the function. Libraries streamline software support to be
more efficient.

Synaptic may be installed from the Ubuntu Software Center and then
found by searching in the Dash for Synaptic Package Manager. Launch it
and you will see the main window, as shown in Figure 5-9.

TIP What’s in a Name?
Why the name Synaptic? Synaptic is a play on words based on your brain’s synapses and
the word APT.
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Installing a Package
As with Ubuntu Software Center, installing pack ages with Synaptic is fairly
easy. After you find the package you wish to install, click the checkbox to
the right of the name of the package and select Mark for Installation. A
dialog box may pop up (Figure 5-10) showing you what dependencies
need to be installed—if any—which you can accept by clicking the Mark
button. After you have selected all the packages you wish to install, click
Apply on the Synaptic toolbar to begin installation.

Removing a Package
To remove a package, click on the box next to the name of an installed
package, and choose Mark for Removal. As with installing a package, you
may be asked to mark additional packages for removal (Figure 5-11).
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Figure 5-9 Synaptic main window



These are generally packages that depend on the presence of the main
package you are marking for removal. If you wish to remove all the config-
uration files too, choose Mark for Complete Removal. After you have
selected the packages you wish to remove, click Apply on the toolbar to
start the process of removing the package.

Finding That Package
So you are looking for a package but don’t know where to start? The fastest
and easiest way is to enter a word in the Quick Search box at the top center
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Figure 5-10 Pop-up on Mark for Installation

Figure 5-11 Pop-up on Mark for Removal



of the Synaptic window. You can also click the Search button on the tool-
bar. By default, the regular search looks at both the package name and the
description, but it can also search just by name or a number of other fields.

If you know what section the package is in, select it in the left pane (you
may need to go back to the Sections pane). Select the button in the lower
left labeled Sections, and browse through the packages in that section.

In addition to Sections, other package listing and sorting options are
worth exploring. You can access them using the buttons at the bottom left
of the Synaptic window. Status lets you sort according to installation sta-
tus. Origin sorts according to the repository from which the software was
installed (or no repository for manually installed software; see the section
later in this chapter on installing software that is not in a repository). You
can even make custom filters to aid your search.

Useful Software Packages to Explore
The software discussed in this section of the chapter is not installed by
default but is known to be useful and well respected. These are given here
as recommendations to help those who have specific needs narrow their
search for programs that meet their requirements.

Creating Graphics with GIMP and Inkscape
GIMP
Package name: gimp
Windows equivalent: Adobe Photoshop or GIMP

The GNU Image Manipulation Program, affectionately known as GIMP
to its friends, is a powerful graphics package. GIMP provides a compre-
hensive range of functionality for creating different types of graphics. It
includes tools for selecting, drawing, paths, masks, filters, effects, and
more. It also includes a range of templates for different types of media
such as Web banners, different paper sizes, video frames, CD covers, floppy
disk labels, and even toilet paper. Yes, toilet paper.
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NOTE In early versions of Ubuntu, GIMP was installed by default, but has not been for several
years, mainly because it is a large package with a specific audience and room was desired
for more general-use packages.

Unlike Adobe Photoshop, GIMP does not place all of its windows inside a
single large window; instead, GIMP has a number of separate child win-
dows. This can be a little confusing at first for new users—especially those
used to Photoshop. To get you started, let’s run through a simple session
in GIMP.

An Example  Start GIMP by searching for it in the Dash.

When GIMP loads, you will see a collection of different windows, as
shown in Figure 5-12.

Close the Tip of the Day window, and you are left with two other windows.
The one on the left in the screenshot is the main tool palette. This window
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Figure 5-12 GIMP does not put everything in one window like Adobe Photoshop.



provides you with a range of different tools that can be used to create your
images. The window on the right provides details of layers, brushes, and
other information. GIMP provides a huge range of different windows that
are used for different things, and these are just two of them.

To create a new image, click File > New. The window shown in Figure 5-13
will appear.

The easiest way to get started is to select one of the many templates. Click
the Template combo box and select 640 × 480. If you click the Advanced
Options expander, you can also select whether to use RGB or grayscale
with the Colorspace box. You can also choose a background fill color or
having a transparent background.

Click OK, and you will see your new image window (Figure 5-14).

To work on your image, use the tool palette to select which tool you want
to use on the new image window. Each time you click on a tool in the
palette, you see options for the tool appear at the bottom half of the
palette window.

When you click the button that looks like an A in the toolbox, it selects the
text tool. At the bottom of the toolbox, you will see the different options.
Click the Font button that looks like an uppercase and a lowercase case A
(like Aa) and select the Sans Bold font. Now click the up arrow on the Size
box, and select the size as 60 px. Move your mouse over to the empty
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Figure 5-13 Lots of templates are available, including one for toilet paper!



image window, and you will see the mouse pointer change to a text carat.
Click in the image, and a box pops up in which you can enter the text to
add to the image. Type in Ubuntu. With the text entry still open, click the
up arrow on the Size box so the text fills most of the window. As you can
see, you can adjust the text while it is in the image. When you are happy
with the formatting, click Close on the text entry box. Your image should
look a little like Figure 5-15.

Now in the toolbox, click the button that has a cross with an arrow on each
end. You can use this tool to move the text around. Click the black text, and
move the mouse.

Let’s now add an effect filter. GIMP comes with a range of different filters
built in. You can access these by right-clicking the image and selecting the
Filters submenu. 

For our image, right-click the image and select Filters > Blur > Gaussian
Blur. In the Horizontal and Vertical boxes, select 5 as the value. Click OK,
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Figure 5-14 Use the right mouse button on the image to access lots of GIMP
options and features.



and the blur is applied to your text. Anything in GIMP can be undone by
clicking Edit > Undo or typing Ctrl-Z. Your image should now look like
Figure 5-16. Now we are going to create another layer and put some text
over our blurred text to create an interesting effect. If the Layers window
isn’t open yet, open it with Windows > Dockable Dialogues > Layers. The
Layers window will now appear.

Layers are like clear plastic sheets that can be stacked on top of each other.
They allow you to create some imagery on one layer and then create
another layer on top with some other imagery. When combined, layers can
create complex-looking images that are easily editable because you can
edit layers individually. Currently, our blurred text is one layer. We can add
a new layer by clicking the paper icon in the Layers dialog box. Another
window appears to configure the layer. The defaults are fine (a transparent
layer the size of your image), so click OK.

Now double-click the black color chip in the toolbox window and select a
light color. You can do this by moving the mouse in the color range and
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then clicking OK when you find a color you like. Now click the text button
from the palette and again add the Ubuntu text. When the text is added, it
will be the same size as before. Now use the move tool and position it over
the blurred text. Now you have the word “Ubuntu” with a healthy glow, as
shown in Figure 5-17!

The final step is to crop the image to remove the unused space. Click
Tools > Transform Tools > Crop, and use the mouse to draw around the
Ubuntu word. You can click in the regions near the corners of the selection
to adjust the selection more precisely. Click inside the selection, and the
image will be cropped. To save your work, click File > Save, and enter a file-
name. You can use the Select File Type expander to select from one of the
many different file formats.

Further Resources  A great start is GIMP’s own help, which is not
installed by default, but if you are on the Internet, the help viewer will
download it automatically. You can also install it by searching for gimp
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help in the Software Center. The GIMP’s own Web site at www.gimp.org
has all the help plus tutorials and more.

Inkscape
Package name: inkscape
Windows/OS X equivalents: Adobe Illustrator, Inkscape, Macromedia Freehand

Inkscape is also a drawing and graphic creation tool, much like GIMP, but
one that has a slightly different focus. Unlike GIMP, which works with
raster graphics, Inkscape is a vector drawing tool. This means rather than a
grid of pixels, each assigned a color, drawings are mathematically described
using angles and arbitrary units.

To get started with Inkscape, launch it by searching for it in the Dash, and
very shortly you will see the default window with the basic canvas of either
Letter or A4 depending on where in the world you live. At the top of the
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Figure 5-17 Combining steps as we have done can result in interesting 
effects such as this.

www.gimp.org


screen, below the menus, are three sets of toolbars. The topmost contains
common tools like save and zoom, the second a series of snapping options,
and the third is changeable depending on the tool selected. 

All the tools are listed on the left-hand side of the menu, starting with
the selection tool and running down to the eyedropper or paint color
selector tool. Let’s get started by drawing a simple shape and coloring it
in (Figure 5-18).

First, select the rectangle tool on the left, just below the zoom icon. Draw a
rectangle anywhere on the screen. Now let’s change the color of the fill and
outside line or stroke.

NOTE With any of the drawing tools, the Shift key will cause objects to grow from the center of
where you clicked and Ctrl will allow you to constrain dimensions and rotation.

With your rectangle still selected, go to the Object menu
and choose Fill and Stroke. Over on the right, you will
see the window appear, with three different tabs: Fill,
Stroke Paint, and Stroke Style. Let’s fill that rectangle
with a gradient from orange to white. Immediately
below the Fill tab, change from Flat color to Linear Gra-
dient (Figure 5-19).

Look back at your rectangle and see the gradient and a
new line running horizontally across the rectangle.
Moving either the square or the circle allows you to
define where the gradient starts and stops. To change
the colors, click the Edit... button. Once the Edit dialog
is up, each end of the gradient is called a stop and can be
edited separately (Figure 5-20).

Now that we have a rectangle, let’s add some text to our
image. Select the Text tool, which is right near the bot-
tom on the left, and click anywhere. A cursor appears,
and you can start typing. Type “Ubuntu,” and then we
are going to change the color and size of the text. Let’s
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Figure 5-18
Inkscape’s toolbar
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Figure 5-19 Your rectangle, now with gradient-filled goodness

Figure 5-20 Gradient editing dialog



make the text 56 points, which can be selected in the upper right, beside
the Font name.

The Fill & Stroke dialog should still be open on the right, but if it isn’t,
reopen it. Change the text color to Red, then choose the selection tool
again. Now drag a box around both the text and the rectangle, and you
should see both selected (Figure 5-21).

Now open the Alignment dialog, which is right near the bottom of the
Object menu. Like the Fill and Stroke dialog, it appears on the right-hand
side. To center the text in the box, see the middle two icons with a line and
some blue lines on the side of them. Click both the Horizontal and Vertical
alignment options, and both the text and image will be centered on the
page (Figure 5-22).

Now that you have created an image, what can you do with it? By default,
Inkscape saves in the SVG or Scalable Vector Graphics format, an open
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standard for vector graphics. If you want to take your work elsewhere for
showing on another computer or printing, Inkscape can also save into
PDF format, although if you choose to do so, make certain you also save a
copy as an SVG so you can edit the image later if you wish. Both SVG and
PDF are options in the Save dialog. One key advantage for PDF is that it
embeds fonts and graphics, meaning your image looks the same on nearly
any computer you show it on. You can also export your image as a PNG for
embedding in a text document or uploading to the Web, although many
modern Web browsers such as Firefox and Chrome can display SVG
directly, although most don’t support the full SVG standard. To export, go
to File > Export, which allows you to choose to export just the objects
selected, the whole document, or some portion.

Hopefully, you have seen just how powerful Inkscape can be. There are
many more things you can do with Inkscape, so play around with the vari-
ous options, dialogs, and shapes.
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Further Resources  A good start is always Inkscape’s own help, which is
in SVG format, so you can see how the original authors created the tutori-
als. Inkscape’s Web site at http://inkscape.org has some great tutorials and
articles. If you want a book, Tav Bah’s Inkscape: Guide to Vector Drawing
Program, Third Edition, is a good place to start.

Desktop Publishing with Scribus
Package name: scribus
Windows equivalents: Adobe InDesign, Scribus

For more powerful document creation than LibreOffice can allow, Scribus
is just the ticket. A desktop publishing application, Scribus is built for
designing and laying out documents of various sizes and sorts. As such, it
makes a few different assumptions that might catch you up if you are used
to using LibreOffice to create your documents.

When you first launch Scribus, it asks you what kind of document you
want to create or if you want to open an existing document. Let’s create a
one-page document and take Scribus for a spin (Figure 5-23).

The first thing to remember about Scribus is that as a desktop publishing
program, it is not designed for the direct editing of images and text. You
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edit and create your images in applications like GIMP or Inkscape and
your text in word processors like LibreOffice and then import them.

For starters, let’s create a pair of text frames. For our example, we are using
a document titled Welcome_to_Ubuntu.odt. To create a text frame, you
need to use the Insert Text Frame tool, which can be found near the
middle of the toolbar. After you draw the text frame, you need to add text
to it. Right-click on the frame and choose Get Text. A dialog very similar to
the Open dialog appears. Choose the Welcome_to_Ubuntu.odt file, and
then select OK. You will be asked a few options; for now, accept the
defaults. You should see the text appear on the screen (Figure 5-24).
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Figure 5-24 The imported text in a frame



NOTE Scribus currently cannot import Microsoft Word documents, so you need to open them in
LibreOffice.org and convert them to .odt files so Scribus can import them.

But as you can see, the text overflows the frame. In order for the rest of
the text to show up, you need to create another text frame and then link
the two, allowing the overflow to appear in the second frame. Go up to the
toolbar again, select the Insert Text Frame, and draw another frame
roughly on the bottom of the page. Then select the first frame and choose
the Link Text Frames icon on the toolbar, which looks like two columns
with an arrow between them. After you have selected that, click on the sec-
ond text box and you should see an arrow appear and, more importantly,
your text will now flow from one frame to the next (Figure 5-25).
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Figure 5-25 Text now flows from frame to frame.



Next let’s insert an image at the bottom of the screen. As with text, you
need to create an image frame, then add the image to that frame. Draw the
image frame below the two text frames, and then right-click and choose
Get Image. Just as with the text import, choose your file, this time an image
file, in the Open dialog, and it will appear in the frame. Let’s choose the
Ubuntu logo, under the Logo folder in Example Content. It will appear in
your image frame (Figure 5-26).

NOTE Scribus can import gif, jpg, png, xpm, psd, tiff, eps, and pdf. It cannot yet import GIMP’s XCF, so
you will need to save any images you create in the GIMP in one of the supported formats.

Now that you have added some text and an image, let’s export to PDF so you
can share your creation with the world. On the toolbar near the left-hand
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Figure 5-26 Your document with an image added



edge, you will see the PDF logo, just to the left of the traffic light icon.
Select that, and don’t worry about the error about the DPI of the image.
Select Ignore Errors, and you will see a large dialog with many options for
embedding fonts and the like. Don’t worry too much about them right
now, as the document you have created isn’t that complicated. Choose a
good name for your document, and then save it to your Documents folder.
Now let’s take a look at your creation in the Document Viewer. Open the
File Manager and load your new document (Figure 5-27).

Now let’s go back to Scribus and save the image in Scribus’s own SLA for-
mat so that you can edit it later if you wish. Enter the name you chose for
the PDF name and save it in the Documents folder as well. You have now
created your first document in Scribus. There is a lot more to explore, so
go and try things out. Just remember to save every now and again.
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Further Resources  As always, Scribus’s own help is a great place to start.
The Scribus Web site at www.scribus.net has a help wiki, further docu-
mentation, and more. There is also an official book, which isn’t out as of
this writing but should be very shortly. Information about it can also be
found on the Scribus Web site.

Creating Music with Jokosher
Package name: jokosher
Windows/OS X equivalents: Garage Band

Musicians abound in the Ubuntu community and the wider world, but
until Jokosher came along, there wasn’t an easy-to-use and simple pro-
gram for creating that music. Founded by Ubuntu’s own Jono Bacon and
named after a kosher joke about the food that is Jono’s name, Jokosher
makes creating music or other audio recordings a breeze. 

To get started in Jokosher, you first need to create a project to hold the var-
ious audio tracks that make up the end file. For our basic project, we are
going to take two of the free culture showcase projects that ship with
Ubuntu and combine them together. Click on the Create a New Project
button in the welcome screen (Figure 5-28) and then on the next window,
enter in Ubuntu combination into the Project Name field. 
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NOTE Jokosher is a nondestructive editor, which means that it doesn’t edit the files you add
directly; rather, it stores the edits and applies them separately.

Once that is open, you will see a largely blank screen and you need to fill
that with sound files. Choose Add Audio File on the upper toolbar and
type in /usr/share/example-content in the location bar. Select one of two
files in the Ubuntu Free Culture Showcase folder. After that is loaded,
select Add Audio File again and select the other audio files. You should see
something like in Figure 5-29.

Now that we have both files loaded, let’s create some sweet solos so that
you can only hear one of the two files. To create a cut in the audio file, sim-
ply double-click wherever you want your cut. So anywhere in the How
Fast.ogg file, double-click and then drag the second piece to the left. 

This will create a very abrupt break in the music, so to make it more pleas-
ing, let’s create a pair of fades on either side. While holding the shift key
down, click near the end of the first part and drag to the end. Release the
mouse and you should see a pair of 100% boxes. Click and drag the right-
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most one down to the bottom where it will read 0%. After you are done,
you should have something like Figure 5-30. 

Now let’s export that file so you can share your awesome creation with
your friends. Go to File > Mixdown Project and in the Mixdown Project,
create a new profile by clicking the plus icon in the upper right. Name is
exported and then click ok. Now you need to add an action, in this case
export, so click on the lower right-most plus icon. Select Export File and
then select Add Action. Now we need to configure the file name, type of
audio file, and where you are going to save it to. Select Export File on the
list and click the little configure icon in the lower right, it looks like a
wrench and screwdriver. Name your file Ubuntu Combination and then
Save it as a FLAC file. In the location bar, click the folder icon and choose
your music folder. After you’re done, it should look like Figure 5-31. Now
click the Mixdown button and your file is created. Go to your Music folder
and hit play for the fun to begin.

We have just scratched the surface with Jokosher. We didn’t get into adding
live instruments and recording them directly, which is where Jokosher
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really shines. But we did get a taste of the power of Jokosher even with a
few simple audio files that come with Ubuntu. Go out and have fun.

Further Resources  As always, Jokosher’s own help is a great place to
start. The Jokosher Web site at www.jokosher.org has a help wiki, further
documentation, and more.

Playing to Learn with Educational Programs
There are many different educational applications available on Ubuntu.
Let’s take a look at just a few of them in the Ubuntu Software Center. Most of
these and others can be found under the Education category in the center.

NOTE There is an easy way to install much of the educational software via preselected package bun-
dles aimed at different age groups, be it preschool, primary, secondary, or tertiary. To install
the bundles, install the ubuntu-edu-preschool, -primary, -secondary, or -tertiary package.

Kalzium
Kalzium presents the pinnacle of periodic table exploration for users of
any ages. In its simplest form, it provides a quick and easy reference to the
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periodic table. Kalzium includes 105 of the naturally occurring elements,
many of which are accompanied by sample pictures. If the user hovers the
mouse pointer over an element symbol in the periodic table, a balloon
appears showing the selected element’s name, atomic number, and mass
(Figure 5-32).

For more advanced users, Kalzium provides a fascinating way to explore the
periodic table. Using the left-hand panel, users have access to the timeline,
boiling point, and melting point sliders. When users move these sliders, the
elements on the periodic table change color according to their dates of dis-
covery, boiling points, or melting points respectively. Users can then start to
see patterns emerging in the periodic table right in front of their eyes.

As well as presenting the basic information, Kalzium provides very
advanced statistics on each of the 105 elements present. 
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Kanagram  
Kanagram is a simple package that messes up the letters of a word to create
an anagram that children must then unscramble. The package comes with
hints, a cheat feature that reveals the word, and built-in word lists, which
can be extended.

KBruch
KBruch is a math program to help students practice the use of fractions. It
comes with four distinct modes of play.

� Fraction Task: In this exercise, the user is given a fraction sum that
must be solved by adding the numerator and denominator. The
difficulty of the sum can be changed by the user, who has control over
the number of fractions to use, the maximum size of the main
denominator, and the mathematical operations to use, such as
addition, subtraction, multiplication, and division.

� Comparison: This exercise is designed to test the user’s understand-
ing of fraction sizes by making him or her compare two given
fractions.

� Conversion: The Conversion mode tests the user’s skills at taking a
given number and converting it into a fraction.

� Factorization: Factorization tests the user in calculating the factors of
a given number. Factorization is a key skill in using and manipulating
fractions.

KHangman
This modern version of a classic game helps children learn to spell and
recognize letter patterns in words. KHangman shows a blank base to start;
as the user chooses letters, they are entered into the word if correct or
placed on the tries list if incorrect, in which case the hangman begins to
grow. KHangman comes with three built-in word lists, but these can be
extended easily.
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Kig
For people wishing to learn about geometrical construction in mathemat-
ics, Kig is a must. It is an extremely powerful package but very simple to
use. Kig allows users to create complex geometrical abstractions from over
thirty simple tools, such as points, parallel and perpendicular lines, arcs,
bisectors, circles, and hyperbola (Figure 5-33). When creating abstrac-
tions, Kig uses other lines and points already on the diagram to lock onto,
making it easy to achieve high precision.

Kig also includes some testing tools. Once a geometrical diagram has been
drawn, it is often required to prove a concept by showing that two lines are
indeed parallel or perpendicular. Kig offers these tools and more in an
easy-to-use manner. Just clicking on the tool prompts the user to choose
the item to test against. Then, each time the user hovers over another item
while moving the cursor around, Kig will pop up with a message to tell
whether or not it satisfies the test case.
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KmPlot  
KmPlot is a mathematical function–graphing program for Edubuntu. The
package has a powerful expression parser built in and can plot different
functions simultaneously and combine their function terms to build more
complex mathematical functions. KmPlot also supports functions with
parameters and functions in polar coordinates. KmPlot can create graphs
to a very high precision, making it excellent for teaching purposes.

Stellarium
With a default catalog of over 600,000 stars, Stellarium is a powerful plan-
etarium designed to show you exactly what you would see with the naked
eye, binoculars, or telescope.

In keeping with the multicultural nature of Ubuntu and Open Source,
Stellarium can show you not only the constellations from the Greek and
Roman traditions (Figure 5-34) but also those of other “sky cultures,” as
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Stellarium describes them, such as the various Chinese, Ancient Egyptian,
and Polynesian traditions.

Stellarium is even capable of driving a dome projector, like you would see
at a large-scale, purpose-built planetarium as well as controlling a wide
variety of telescopes directly.

KTouch  
In this day and age, typing is an everyday occurrence for most people.
KTouch is a tutor that gives help and support to those wishing to learn the
art of touch typing. With fifteen levels and automatic level progression,
KTouch is a fairly advanced tutor program, offering statistics and alterna-
tive language options, too.

KTurtle  
KTurtle is a Logo programming language interpreter for Edubuntu. The
Logo programming language is very easy to learn, and thus young children
can use it. A unique quality of Logo is that the commands or instructions
can be translated, so the user can program in his or her native language.
This makes Logo ideal for teaching children the basics of programming,
mathematics, and geometry. One of the reasons many children warm to
Logo is that the programmable icon is a small turtle, which can be moved
around the screen with simple commands and can be programmed to
draw objects (Figure 5-35).

By typing in commands such as turnleft 90, forward 4, children are using a
language native to themselves while also learning procedural logic. KTur-
tle can even handle simple subroutines, so it’s easy to extend the program-
ming onward and upward.

With the introduction of KDE 4, Edubuntu includes a group of brand new
educational packages. Next is a brief summary of each new application.

Marble  
Marble, the desktop globe, is a virtual globe and world atlas, which can be
utilized to learn more about the Earth. With the ability to pan and zoom,
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click on a label to open a corresponding Wikipedia article, and view the
globe and maps with various projections, Marble is a welcome addition to
Edubuntu’s educational packages.

Parley
Parley, the digital flash card, allows you to easily remember things utilizing
the spaced repetition learning method, otherwise known as flash cards.
Features include different testing types, fast and easy setup, multiple lan-
guages, the ability to share and download flash cards, and much more.

Step
Step is an interactive physics simulator that allows you not only to learn
but to feel how physics works. By placing bodies on the scene and adding
some forces such as gravity or springs, you can simulate the law of physics,
and Step will show you how your scene evolves.
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Blinken
Blinken takes you back, back to the 1970s, as a digital version of the
famous Simon Says game. Watch the lights, listen to the sounds, and then
try to complete the sequence in order. Blinken provides hours of fun with
the added benefit of learning.

Others Not on the Education Menu
Some educational applications are not located in the Education menu in
the software center. Here are brief descriptions of two of them.

� Tux Paint: Tux Paint is a drawing package for younger children.
Although geared toward a younger audience, Tux Paint still packs in
some of the more advanced features of drawing packages and can
draw shapes, paint with different brushes, use a stamp, and add text to
the image. The Magic feature allows many of the more advanced tools
normally found in full-fledged photo editors to be used, such as
smudge, blur, negative, tint, and many more. There is also the facility
to save as well as print.

� GCompris: GCompris is a set of small educational activities aimed at
children between two and ten years old and is translated into over
forty languages. Some of the activities are game oriented and at the
same time educational. Among the activities, there are tasks to
educate children in computer use, algebra, science, geography,
reading, and more. More than eighty activities are available in the
latest release.

Summary
In this chapter, you learned how to install and use just a few of the addi-
tional applications available for Ubuntu. Although this chapter only
scratched the surface of what each application can do, you should have
enough of an understanding of each to get started with them, and the Fur-
ther Resources sections should help you become an expert. But beyond
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what is in this chapter, the vast universe of new programs is available. Go
and explore—try out something new. At worst, you will have wasted a few
hours, but you might find something that will change your life.

Always remember that there is a wealth of help and documentation
 available online. If you ever find yourself stuck, take a look at the Ubuntu
Web site at www.ubuntu.com or the Ubuntu documentation at http://
help.ubuntu.com and make use of the forums, wiki, mailing lists, and
IRC channels.
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DVDs, 101–102

Movie Player program, 100

remote control, 101–102

streaming, 100

Videos folder, 69

VirtualBox, 234

Virtualization, 232–234

VMware, 233

Volkerding, Patrick, 14

W
Warsaw, Barry, 303–304

Warthogs

founding of Ubuntu, 2, 9–10

ideal operating system, 10

Warty Warthog, 2

Watson, Colin, 302

Web browsing. See Firefox.

Web forums, 282–283

Wheeler, Matt, 303

who command, 194

Wikis, 283–286

Wildcards, 195–196

Window management

keyboard shortcuts, 

116–117

plug-ins, 179
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Windows

installing Ubuntu from, 59

partitions, mounting, 114

Windows key, 115

Wine Windows emulator,

119–120

Wireless network information,

displaying, 192

Wonderly, David, 245

Word processing. See LibreOffice.

Workspace management,

keyboard shortcuts, 118

World atlas, 159–160

X
Xen, 233–234

Xfce window management

system, 249–251

Xubuntu, 36, 249–251

Z
zcat command, 230. See also cat

command.

zgrep command, 230. See also

grep command.

Zimmerman, Matt, 302

zless command, 230. See also

less command.

Zoning, 233

z/VM, 233
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